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This manual is not a complete guide of Arduino. The main purpose of this manual is to 
introduce you to the world of Arduino for education with a specific type of robots.  

 

 



 

Programming the Robot 

What is Arduino? 
 
Microcontrollers have existed since many years. Every automation in home or industry has 
some type of microcontroller inside.  
Arduino is, in essence, another microcontroller. Yet, it has some special facts: 

● It's open-source 
● It's easy to use. 
● It's cheap 
● It has a huge community contributing with free software and hardware. 
● It can be programmed in a “C like” language,  
● There are optional programming environments, like Scratch.  
● No special training hardware or assembler knowledge neede. 
● It can be connected to computers via USB.  
● Free multi-platform IDE to program Arduino.  

 
Arduino is not only a board with a microcontroller, it's a world-wide movement, a essential 
part of the ecosystem of free software and hardware and a way of thinking.  
For those reasons, Arduino is one of the best tools for teaching electronics, robotics or 
programming. It’s very suitable for ESTEAM projects obviously for the technology side, but 
also because it’s inclusive for the price and the learning curve. And there are many online 
resources for making art with this ecosystem.  
 
You can find resources, manuals, tutorials and anything you need to start with Arduino in 
https://www.arduino.cc/.  
We recommend to visit the project hub (https://create.arduino.cc/projecthub) to search for 
similar projects. Also, we recommend the official forum: https://forum.arduino.cc/.  
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Getting started. 
 
In other manuals of this project there are recommendations for different hardware.  But to 
start, we only need a computer, an Arduino UNO, a LED and an USB wire. 
 
First we need to download the Arduino IDE 
https://www.arduino.cc/en/Main/Software#download  
 
Each Operating System has his own method to install the software, but It’s very easy and we 
can find instructions here: https://www.arduino.cc/en/Guide/HomePage  
 
Once Arduino IDE is working, we can see a simple text editor similar to the processing 
language editor.  
 

 
 
  
The first thing we can do is to create our first sketch and upload it to the board. To do so, we 
need to have it connected to the computer. 
 
If you are using Windows, maybe you need to install a controller from this web: 
https://www.arduino.cc/en/guide/windows 
If you are using Macintosh or Linux, you don’t need to install anything.  
The port is a COM port and you can find it in devices manager.  
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In the Arduino IDE you can choose the correct device from Tools > Port and check if it’s 
correct in Tools > Get Board Info. 
 
We won't do a troubleshooting manual, but if you run into problems, you can search in 
Internet and find every solution to any error message. 
 

The Arduino “Hello World” 
 
Arduino is an interactive device. It can sense the environment (sensors), process this 
information and interact with the environment, the Internet or the user (actuators, serial 
port...).  
 
The typical first project with Arduino is to make a LED blink. You can connect the LED to the 
digital port 13 and GND. Remember that the short wire is the cathode and the long is the 
anode of the LED. 
 

 
 
Next, we can write our first program: 
 
const int LED = 13; 

void setup() { 

  // initialize digital pin LED as an output. 

  pinMode(LED, OUTPUT); 

} 

 

// the loop function runs over and over again forever 

void loop() { 

  digitalWrite(LED, HIGH);   // turn the LED on (HIGH is the voltage level) 

  delay(1000); // wait for a second 

  digitalWrite(LED, LOW); // turn the LED off by making the voltage LOW 

  delay(1000); // wait for a second 
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As you can see, programming for Arduino is not difficult because there are lots of things 
simplified. Let’s take a look: 

● We have a setup function to initialize Arduino pins. 
● We have a loop function that will run forever while the board is connected to a power 

supply.  
● In this sketch, we have set a variable called LED with the number 13.  
● In the setup function we have set the 13 pin as an OUTPUT pin. Digital pins can be 

INPUT or OUTPUT.  
● OUTPUT, INPUT, HIGH and LOW are constants in the Arduino language. 
● The function digitalWrite() is provided by Arduino language to manipulate digital pins.  

 
Next, you have to verify the code with the check button. If it is correct, you can upload the 
sketch to the Arduino board with the arrow button.  
While uploading, the onboard LED and your LED will blink rapidly. When the upload is 
complete and the program starts, the LED will blink with one second period. 

Other languages 
 
For a computer science teacher, it's not difficult to program with the official IDE of Arduino. 
But, for students or other type of teachers, there are other easier alternatives.  

Ardublock 
The first alternative could be Ardublock (http://blog.ardublock.com/ ). It’s a block editor like 
Scratch, but it can be installed as a plug-in for the arduino IDE.  
Let’s see the example below made using this language: 
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S4A 
We also recommend Scratch for Arduino or S4A (http://s4a.cat/index.html) it is a modification 
of Scratch making it compatible with Arduino. You need to install a program and a firmware 
in Arduino to communicate with the program.  
SA4 is very easy and powerful, and students might be familiarized with Scratch before.  
 
The blink led example can be programmed in the following way: 
 

 
 
 
 

Ardublock or S4A are very good alternatives to text programming, but robots could be 
complicated and if you are thinking in competition where time is important, there is nothing 
as fast as text code. So we recommend to use the official Arduino IDE.  
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Push Buttons 
 
In this example, we are going to control the behaviour of a LED with a button. You can make 
this circuit with your protoboard: 
 

 
You need a protoboard, a LED, a button and a 10K Ohm resistor.  
 
If you want to light the LED when you push the button: 
 
// constants won't change. They're used here to set pin numbers: 

const int button = 8; // the number of the pushbutton pin 

const int led =  13; // the number of the LED pin 

// variables will change: 

int buttonState = 0; // variable for reading the pushbutton status 

 

void setup() { 

  // initialize the LED pin as an output: 

  pinMode(led, OUTPUT); 

  // initialize the pushbutton pin as an input: 

  pinMode(button, INPUT); 

} 

 

void loop() { 

  // read the state of the pushbutton value: 

  buttonState = digitalRead(button); 

  // check if the pushbutton is pressed. If it is, the buttonState is HIGH: 

  if (buttonState == HIGH) { 

// turn LED on: 

digitalWrite(led, HIGH); 

  } else { 

// turn LED off: 

digitalWrite(led, LOW); 

  } 

} 
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You can see various new things: 
● A variable (buttonState) to read the button status. 
● A pin set to INPUT mode. 
● The digitalRead() function to set the variable buttonState. 

 
In the following example, you don’t need to change the circuit, only the program. The goal is 
to toggle the LED when pressing the button. This problem is interesting because it involves 
not only programming, but dealing with physical variables that the programmer can not 
control: push time and the electric imperfections of the button. An only programing approach 
could take different lectures of the button and the result could be unpredictable. This is one 
of the official examples of Arduino to solve it: 
 
const int buttonPin = 2; // the number of the pushbutton pin 

const int ledPin = 13; // the number of the LED pin 

 

int ledState = HIGH; // the current state of the output pin 

int buttonState; // the current reading from the input pin 

int lastButtonState = LOW;   // the previous reading from the input pin 

 

// the following variables are unsigned longs because the time, measured in 

// milliseconds, will quickly become a bigger number than can be stored in an int. 

unsigned long lastDebounceTime = 0;  // the last time the output pin was toggled 

unsigned long debounceDelay = 50; // the debounce time; increase if the output flickers 

 

void setup() { 

  pinMode(buttonPin, INPUT); 

  pinMode(ledPin, OUTPUT); 

  // set initial LED state 

  digitalWrite(ledPin, ledState); 

} 

 

void loop() { 

  // read the state of the switch into a local variable: 

  int reading = digitalRead(buttonPin); 

  // check to see if you just pressed the button 

  // (i.e. the input went from LOW to HIGH), and you've waited long enough 

  // since the last press to ignore any noise: 

  // If the switch changed, due to noise or pressing: 

  if (reading != lastButtonState) { 

// reset the debouncing timer 

lastDebounceTime = millis(); 

  } 

 

  if ((millis() - lastDebounceTime) > debounceDelay) { 

// whatever the reading is at, it's been there for longer than the debounce 

// delay, so take it as the actual current state: 

// if the button state has changed: 

if (reading != buttonState) { 

 buttonState = reading; 

 

 // only toggle the LED if the new button state is HIGH 

 if (buttonState == HIGH) { 
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 ledState = !ledState; 

 } 

} 

  } 

  // set the LED: 

  digitalWrite(ledPin, ledState); 

  // save the reading. Next time through the loop, it'll be the lastButtonState: 

  lastButtonState = reading; 

} 

 
The example above is crucial, because not only you have to think in solving the algorithm, 
you also have to control the hard world of the hardware.  

Sensors 
There are many types of sensors for the arduino, we'll explore through the most useful ones 

Light sensor: 
A LDR is a light sensor that works as a resistor. When the ambiance is dark, the resistance 
is very high, when the ambiance is lighted, the LDR is a good conductor.  
 
For the next example, you need to build this circuit: 
 

 
This code sets the speed of blinking reading the light sensor: 
 
int sensorPin = A0; // select the input pin for the potentiometer 

int ledPin = 9; // select the pin for the LED 

int sensorValue = 0;  // variable to store the value coming from the sensor 

 

void setup() { 

  // declare the ledPin as an OUTPUT: 

  pinMode(ledPin, OUTPUT); 

} 

 

void loop() { 

  // read the value from the sensor: 

  sensorValue = analogRead(sensorPin); 

  // turn the ledPin on 
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  digitalWrite(ledPin, HIGH); 

  // stop the program for <sensorValue> milliseconds: 

  delay(sensorValue); 

  // turn the ledPin off: 

  digitalWrite(ledPin, LOW); 

  // stop the program for for <sensorValue> milliseconds: 

  delay(sensorValue); 

} 
 
You can find some new things: 

● An analog pin (A0). 
● An analogRead() function to get the sensor readout and set the sensorValue 

variable.  
 
We are going to set the intensity of the light for the LED depending on the LDR. You don’t 
have to change the circuit. 
 
Remember that the 3,5,6,9,10 and 11 pins are digital pins with PWM* to simulate analog 
output. 
 
The code is 
 
int sensorPin = A0; // select the input pin for the potentiometer 

int ledPin = 9; // select the pin for the LED 

int sensorValue = 0;  // variable to store the value coming from the sensor 

 

void setup() { 

  // declare the ledPin as an OUTPUT: 

  pinMode(ledPin, OUTPUT); 

} 

 

void loop() { 

  // read the value from the sensor: 

  sensorValue = analogRead(sensorPin); 

  analogWrite(ledPin, sensorValue/4); 

  delay(10); 

} 
 
 
 

PWM: 
A digital output can change the state very quickly, so quickly that we can’t see the change. 
But if we connect a LED to this pin, we can see less light. This is called “Pulse With 
Modulation” Arduino simplifies the code providing some pins with PWM and we only have 
to call the function analogWrite() 
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Ultrasonic Sensor 
Like bats do, the ultrasonic sensor uses sonar to determine the distance to an objects. It 
can’t be affected by solar light or black materials. It is very accurate and stable.  
 
For using the sensor you need a circuit like this: 
 

 
 
And the code for testing the Ultrasonic sensor is very simple:  
 

const int trigPin = 8; 

const int echoPin = 9; 

// defines variables 

long duration; 

int distance; 

void setup() { 

pinMode(trigPin, OUTPUT); // Sets the trigPin as an Output 

pinMode(echoPin, INPUT); // Sets the echoPin as an Input 

Serial.begin(9600); // Starts the serial communication 

} 

void loop() { 

// Clears the trigPin 

digitalWrite(trigPin, LOW); 

delayMicroseconds(2); 

// Sets the trigPin on HIGH state for 10 micro seconds 

digitalWrite(trigPin, HIGH); 

delayMicroseconds(10); 

digitalWrite(trigPin, LOW); 

// Reads the echoPin, returns the sound wave travel time in microseconds 

duration = pulseIn(echoPin, HIGH); 

// Calculating the distance 
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distance= duration*0.034/2; 

// Prints the distance on the Serial Monitor 

Serial.print("Distance: "); 

Serial.println(distance); 

} 

 
Here we have some new things: 

● We use two digital pins as input and output for the sonar.  
● We use the Serial.begin and print to send the information to the computer.  
● In the loop, we send 10 microseconds of sound to the trigPin (output). 
● We then, use the pulseIn 

(https://www.arduino.cc/reference/en/language/functions/advanced-io/pulsein/) 
function to measure the duration of the sound that we are capturing. 

● If the duration is long, the sound has taken more time to arrive and there are more 
distance. We can calculate the distance if we know the speed of sound (340m/s). 

 
We can use this sensor in robots to avoid obstacles. Many robot makers put more than one 
sensor in various directions to improve the collision detection. You can also put a servo to 
rotate the sensor before decide where to go. This is explained later in this manual. 
 
In order to simplify the sensor management, you can use the a ultrasonic.h library. There 
are many libraries. We recommend to use the library browser in Arduino IDE to find a good 
one. For example: 
 
// Ultrasonic - Library for HR-SC04 Ultrasonic Ranging Module. 

// Rev.4 (06/2012) 

// J.Rodrigo ( www.jra.so ) 

// more info at www.ardublog.com 

 

#include <Ultrasonic.h> 

 

Ultrasonic ultrasonic(9,10); // (Trig PIN,Echo PIN) 

 

void setup() { 

  Serial.begin(9600);  

} 

 

void loop() 

{ 

  Serial.print(ultrasonic.Ranging(CM)); // CM or INC 

  Serial.println(" cm" ); 

  delay(100); 

} 
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QTR-8[A-RC] reflective sensor array. 
 
Basic robots usually avoid obstacle and follow lines. To follow lines, a robot needs to use 
some infrared sensors to detect the different IR reflectance of the ground.  
 
The QTR-8A outputs an analog voltage that can be measured by an analog-to-digital 
converter (ADC). The QTR-8RC outputs require a digital I/O line capable of driving the 
output line high and then measuring the time for the output voltage to decay to measure the 
reflectance. We recommend the QTR-8RC.  
 
In order to use this sensor array, you need to use the library QTRSensors you can find by 
the menu Sketch>Include Library>Manage Libraries. If it doesn’t work you can download 
manually the library here: https://github.com/pololu/qtr-sensors-arduino/releases.  
 
Once this is done, you can create a QTRSensorsRC object for your sensor: 
 
// create an object for four QTR-xRC sensors on digital pins 0 and 9, and on analog 

// inputs 1 and 3 (which are being used as digital inputs 15 and 17 in this case) 

QTRSensorsRC qtrrc((unsigned char[]) {0, 9, 15, 17}, 4); 
 
The constructor needs an array of digital pins.  
 
You can find some examples at File > Examples > QTRSensors. For example the 
QTRRCRawValuesExample, wich show the raw reading by the serial monitor. 

Calibration 
Calibrating your sensors can lead to more reliable sensor readings. We recommend you to 
build a calibration phase into the initialization routine. It can be as simple as a repetition of 
the calibrate() method during a fixed time. During this calibration time, you need to expose 
each sensor to the lightest and darkest surfaces it will encounter.  
 
#include <QTRSensors.h> 

  

// create an object for your type of sensor (RC) 

// in this example we have three sensors on analog inputs 0 - 2, a.k.a. digital pins 14 - 

16 

QTRSensorsRC qtr((char[]) {14, 15, 16}, 3); 

void setup() 

{ 

  // optional: wait for some input from the user, such as  a button press 

  // then start calibration phase and move the sensors over both 

  // reflectance extremes they will encounter in your application: 

  int i; 

  for (i = 0; i < 250; i++)  // make the calibration take about 5 seconds 

  { 

    qtr.calibrate(); 

    delay(20); 
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  } 

  // optional: signal that the calibration phase is now over and wait for further 

  // input from the user, such as a button press 

} 

 

Reading the sensors 
 
You can read the sensor values using the read() method or, if it is calibrated, the 
readCalibrated() method. With readCalibrated(), the values are from 0 (White) to 1000 
(black).  
For line-detection, you can use the readLine() method. Which takes an optional parameter 
that indicates whether the line is white on black or black on white and a boolean that 
indicates whether the IR emitters should be on or off during the measurement. The result is 
0 if the sensors detect that the line is on or outside of sensor 0 and returns 1000*(N-1) for 
each sensor. If whe use the QTR8-RC, the values will be 0, 1000, 2000, 3000, 4000, 5000, 
6000, 7000 and 8000 depends on the position of the line.  
 
Example of a rudimentary line following: 
 
void loop() 

{ 

  unsigned int sensors[3]; 

  // get calibrated sensor values returned in the sensors array,  

  // along with the line position. 

  // position will range from 0 to 2000,  

  // with 1000 corresponding to the line over the middle sensor. 

  int position = qtr.readLine(sensors); 

  // if all three sensors see very low reflectance,  

  // take some appropriate action for this situation. 

  if (sensors[0] > 750 && sensors[1] > 750 && sensors[2] > 750) 

  { 

    // do something.  

    // Maybe this means we're at the edge of a course or about to fall off 

    // a table, in which case, we might want to stop moving, back up, and turn around. 

    return; 

  } 

  

  // compute our "error" from the line position.  

  // We will make it so that the error is zero 

  // when the middle sensor is over the line,  

  // because this is our goal.  Error will range from 

  // -1000 to +1000.  

  // If we have sensor 0 on the left and sensor 2 on the right,  a reading of 

  // -1000 means that we see the line on the left  

  // and a reading of +1000 means we see the 

  // line on the right. 

  int error = position - 1000; 

  

  int leftMotorSpeed = 100; 

  int rightMotorSpeed = 100; 
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  if (error < -500)  // the line is on the left 

    leftMotorSpeed = 0;  // turn left 

  if (error > 500)  // the line is on the right 

    rightMotorSpeed = 0;  // turn right 

  // set motor speeds using the two motor speed variables above 

} 

 

This is the most simple example possible, but if you want a more accurate movements, you 
may need to use PID https://en.wikipedia.org/wiki/PID_controller  

Arduino Motor shield 
 
In order to make a robot, we need sensors and motors. The official Arduino Motor Shield is 
the one we recommend. It is not very expensive, compatible with Arduino Uno and you can 
find a lot of documentation about it.  
 
A shield is a board that can be placed on top of the Arduino and whose connectors adapt 
perfectly in the Arduino Uno. The shield uses some of the pins of the Arduino and exposes 
all the other.  
 
The technical specifications and how to mount it can be consulted here: 
https://store.arduino.cc/arduino-motor-shield-rev3  
 
This shield has two separate channels, called A and B. Each one uses 4 of the Arduino pins 
to drive or sense the motor. In total, there are 8 pins used by this shield. You can use each 
channel separately to drive two DC motors or combine them to drive one bipolar stepper 
motor. The shield's pins, divided by channel are shown in the table below:  
 

Function pins per Ch. A pins per Ch. B 

Direction D12 D13 

PWM D3 D11 

Brake D9 D8 

Current Sensing A0 A1 

 
If you don't need the Brake and the Current Sensing and you also need more pins for your 
application, you can disable this features by cutting the respective jumpers on the back side 
of the shield. 
 
This schema shows the motor connections. The motor shield can power the Arduino board, 
but this is not recommended. 
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Here you can see a basic code to show how to control motors with Arduino and the motor 
shield: 
 
 
/************************************************************* 

Motor Shield 2-Channel DC Motor Demo 

by Randy Sarafan 

 

For more information see: 

https://www.instructables.com/id/Arduino-Motor-Shield-Tutorial/ 

 

*************************************************************/ 

 

void setup() { 

  //Setup Channel A 

  pinMode(12, OUTPUT); //Initiates Motor Channel A pin 

  pinMode(9, OUTPUT); //Initiates Brake Channel A pin 

  //Setup Channel B 

  pinMode(13, OUTPUT); //Initiates Motor Channel A pin 

  pinMode(8, OUTPUT);  //Initiates Brake Channel A pin 

} 

 

void loop(){ 

  //Motor A forward @ full speed 

  digitalWrite(12, HIGH); //Establishes forward direction of Channel A 

  digitalWrite(9, LOW);   //Disengage the Brake for Channel A 

  analogWrite(3, 255);   //Spins the motor on Channel A at full speed 

  //Motor B backward @ half speed 

  digitalWrite(13, LOW);  //Establishes backward direction of Channel B 

  digitalWrite(8, LOW);   //Disengage the Brake for Channel B 

  analogWrite(11, 123); //Spins the motor on Channel B at half speed 

 

  delay(3000); 
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  digitalWrite(9, HIGH);  //Engage the Brake for Channel A 

  digitalWrite(8, HIGH);  //Engage the Brake for Channel B 

 

  delay(1000); 

  

  //Motor A backward @ full speed 

  digitalWrite(12, LOW);  //Establishes backward direction of Channel A 

  digitalWrite(9, LOW);   //Disengage the Brake for Channel A 

  analogWrite(3, 123); //Spins the motor on Channel A at half speed 

  //Motor B forward @ full speed 

  digitalWrite(13, HIGH); //Establishes forward direction of Channel B 

  digitalWrite(8, LOW);   //Disengage the Brake for Channel B 

  analogWrite(11, 255);   //Spins the motor on Channel B at full speed 

  

  delay(3000); 

  

  digitalWrite(9, HIGH);  //Engage the Brake for Channel A 

  digitalWrite(8, HIGH);  //Engage the Brake for Channel B 

  

  delay(1000); 

} 

 

Avoiding obstacles with Arduino robot 
 
We can combine the sonar sensor with the motor shield to make a robot that can avoid 
obstacles. This demonstration is only about avoiding obstacles with a two motors robot, but 
you may need to add some “intelligence” to avoid obstacles and reach a goal.  
 
This is the example of a simple robot that avoid obstacles with a fixed ultrasonic sensor: 
 

#include "Ultrasonic.h"  

 

Ultrasonic ultrasonic(A0,A5); 

 

long microsec = 0; 

float distanceCM = 0; 

 

void setup() { 

  Serial.begin(9600); 

  

  //Setup Channel A 

  pinMode(12, OUTPUT); //Initiates Motor Channel A pin 

  pinMode(9, OUTPUT); //Initiates Brake Channel A pin 

  //Setup Channel B 

  pinMode(13, OUTPUT); //Initiates Motor Channel A pin 

  pinMode(8, OUTPUT);  //Initiates Brake Channel A pin 

 

} 

void loop() { 

  microsec = ultrasonic.timing(); // reading the sensor 
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  //convert the distance to cm 

  distanceCM = ultrasonic.convert(microsec,Ultrasonic::CM); 

  Serial.print(distanceCM); 

  Serial.println(" cm"); 

 

  if (distanceCM > 8){ 

 

  //Motor A forward @ full speed 

  digitalWrite(12, LOW);  //Establishes backward direction of Channel A 

  digitalWrite(9, LOW);   //Disengage the Brake for Channel A 

  analogWrite(3, 123); //Spins the motor on Channel A at half speed 

  //Motor B forward @ full speed 

  digitalWrite(13, HIGH); //Establishes forward direction of Channel B 

  digitalWrite(8, LOW);   //Disengage the Brake for Channel B 

  analogWrite(11, 123);   //Spins the motor on Channel B at half speed 

 

  } 

  if (distanceCM <= 5){ 

  //Motor A backward @ full speed 

  digitalWrite(12, HIGH);  //Establishes forward direction of Channel A 

  digitalWrite(9, LOW);   //Disengage the Brake for Channel A 

  analogWrite(3, 123); //Spins the motor on Channel A at half speed 

  //Motor B backward @ full speed 

  digitalWrite(13, LOW); //Establishes backward direction of Channel B 

  digitalWrite(8, LOW);   //Disengage the Brake for Channel B 

  analogWrite(11, 255);   //Spins the motor on Channel B at full speed 

  }  

} 
 
Our final design is a robot with tree ultrasonic sensors in front. One is looking forward and 
the other are 45º to the left or the right. The decision about the way is to choose the sensor 
with more distance. Here is a simple example of our robot avoiding obstacles: 
 
#include "Ultrasonic.h"  

 

Ultrasonic ultrafront(7,6); 

Ultrasonic ultraleft(5,4); 

Ultrasonic ultraright(2,1); 

 

long microsec = 0; 

float distanceCM = 0; 

 

void setup() { 

  //Setup Channel A 

  pinMode(12, OUTPUT); //Initiates Motor Channel A pin 

  pinMode(9, OUTPUT); //Initiates Brake Channel A pin 

  //Setup Channel B 

  pinMode(13, OUTPUT); //Initiates Motor Channel A pin 

  pinMode(8, OUTPUT);  //Initiates Brake Channel A pin 

} 

void loop() { 

  microsecfront = ultrafront.timing(); // reading the sensor 

Skills RObots BOosts.  

Page: 18 / 20 



 

Programming the Robot 

  microsecleft = ultraleft.timing(); // reading the sensor 

  microsecright = ultraright.timing(); // reading the sensor 

 

 

  //convert the distance to cm 

  distanceCMfront = ultrafront.convert(microsecfront,Ultrasonic::CM); 

  distanceCMleft = ultraleft.convert(microsecleft,Ultrasonic::CM); 

  distanceCMright = ultraright.convert(microsecright,Ultrasonic::CM); 

 

 

  if (distanceCMfront > distanceCMleft && distanceCMfront > distanceCMright){ 

      //Motor A forward @ full speed 

  digitalWrite(12, LOW);  //Establishes backward direction of Channel A 

  digitalWrite(9, LOW);   //Disengage the Brake for Channel A 

  analogWrite(3, 123); //Spins the motor on Channel A at half speed 

     //Motor B forward @ full speed 

  digitalWrite(13, HIGH); //Establishes forward direction of Channel B 

  digitalWrite(8, LOW);   //Disengage the Brake for Channel B 

  analogWrite(11, 123);   //Spins the motor on Channel B at half speed 

  } 

 

  if (distanceCMleft > distanceCMfront && distanceCMleft > distanceCMright){ 

     //Motor A backward @ full speed 

  digitalWrite(12, HIGH);  //Establishes forward direction of Channel A 

  digitalWrite(9, LOW);   //Disengage the Brake for Channel A 

  analogWrite(3, 123); //Spins the motor on Channel A at half speed 

     //Motor B forward @ full speed 

  digitalWrite(13, HIGH); //Establishes forward direction of Channel B 

  digitalWrite(8, LOW);   //Disengage the Brake for Channel B 

  analogWrite(11, 123);   //Spins the motor on Channel B at half speed 

  } 

 

  if (distanceCMright > distanceCMleft && distanceCMright > distanceCMfront){ 

      //Motor A forward @ full speed 

  digitalWrite(12, LOW);  //Establishes backward direction of Channel A 

  digitalWrite(9, LOW);   //Disengage the Brake for Channel A 

  analogWrite(3, 123); //Spins the motor on Channel A at half speed 

     //Motor B backward @ full speed 

  digitalWrite(13, LOW); //Establishes backward direction of Channel B 

  digitalWrite(8, LOW);   //Disengage the Brake for Channel B 

  analogWrite(11, 255);   //Spins the motor on Channel B at full speed 

  }  

} 
 
 
 

  

Skills RObots BOosts.  

Page: 19 / 20 



 

Programming the Robot 

Last words 
To summarize, we have several tips to give: 
 

● Remember that not all tutorials use the same hardware. For example, almost all 
tutorials for robots use the Adafruit motor shell. Many of them use an obsolete 
version of this. You have to adapt the code to your hardware. 

● Many users have made their own library for sensors or other things. You can use it, 
but we recommend to use the more ‘official’ libraries you can find. 

● The last examples we have written in this tutorial are intentionally made with different 
libraries or hardware to force you to read and test all the code you can find.  

● Motors speeds, delays, servo angles or sensors calibration are specific for the 
hardware you have.  

● Arduino is not only for robots. We recommend to explore other projects like art 
installations, domotics or industrial automation.  
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